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BUSI 201: Business Data Analysis

Spring 2024

Topic 1. Power Query: Pivot

Utilizing the Power Query tool, we can seamlessly transform data between the ‘wide’ and ‘long’ for-
mats. The table on the left represents the ‘long’ format, while the one on the right represents the ‘wide’
format. The ability to switch between these formats proves valuable for tasks such as data cleaning and
analysis. The choice of format may depend on the specific task at hand or the statistical software available
to the user. Moving from the left to right is known as “Pivot,” and moving from the right to the left is
“Unpivot.”
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Let’s retrieve some data from the internet to practice. We’ll use the 2023 Worldwide Box Office statis-
tics available at Box Office Mojo. Navigate to the Data tab, choose From Web, enter the address, and click
OK. The web URL is https://www.boxofficemojo.com/year/world/2023/.

From Web
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URL
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Figure 1: Importing 2023 Box Office Data


https://www.boxofficemojo.com/year/world/2023/

Select Table 0 and eliminate unnecessary columns, specifically Rank, %, and %2. It’s important
to note that the current data is in the ‘wide’ format, with separate columns for domestic, foreign, and
worldwide box office numbers. Our goal is to convert this into the ‘long’ format, where each movie
occupies three rows, and each row contains information on worldwide, domestic, and foreign box office
statistics. Go to Transform, and then choose the columns with box office statistics in the
Next, select Unpivot.
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Figure 2: Unpivoting Box Office Statistics

By following the instructions above, you will achieve the results depicted in Figure 3. Now, you can
observe that the data is arranged in the ‘long’ format, with each movie spanning three rows. Each row
represents the film’s worldwide, domestic, and foreign performance.
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Figure 3: Box Office Statistics in ‘Long’



Changing Data Types

Upon observing Figure 3, it becomes apparent that the data type is not consistent across all entries.
Specifically, the values for worldwide box office performance do not seem to match the other two. To
address this disparity, navigate to Home, select the Value column, click Data Type, and then choose
Currency. After following these steps, you will notice that the entire Value column now adheres to a
uniform style.
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Figure 4: Changing Data Types

Importing to Excel

By selectingClose & Load afterimporting the results mentioned above, we will successfully import
the target data from the Box Office Mojo webpage into an Excel worksheet, as illustrated in Figure S.
Choose Attendance in the navigator window and proceed to select Transform Data as usual.
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Figure S: Imported Data



Another Use of Pivot in Power Query

This time, let’s explore the Pivot function in Power Query and learn how to import data from an-
other spreadsheet. Refer to Figure 6 for guidance on importing data from other workbooks. Choose
BUSI201-LEC20-Workbook.x1sx, which includes a hypothetical attendance sheet for a college-level
course. We will use the Power Query Pivot function to transform this data.
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Figure 6: Importing from Workbooks

The attendance sheet will be visible in Power Query, as illustrated in Figure 7. Before proceeding with
pivots, there are some changes we need to make. As the first row of the data contains variable names, select
Use First Row as Headers.
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Figure 7: Power Query Editor for Attendance



Our goal is to transform this data into a form that will work with PivotTables. In its current form,
building a PivotTable based on this data is challenging, as each date’s attendance record takes up an entire
column. We will transform this data by “unpivoting” some columns. Select the variables that should not
be “unpivoted,” which are Name, Major, and Class in this example. Then, navigate to Transform,
select the drop-down menu next to Unpivot Columns,and choose Unpivot Other Columns.
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Figure 8: Unpivoting the Attendance Sheet

The “unpivoted” data will appear as shown in Figure 9. We will now demonstrate how to efficiently
handle dates in Excel using Power Query and construct tables showing monthly/weekly attendance of
the students in the dataset.
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Figure 9: Unpivoted Attendance Data



Dates in Power Query

Let’s start by renaming the columns from Attribute to Date and from Value to Attendance.!
At this point, Excel may not recognize the unpivoted Date column as dates. Refer to Figure 11, and notice
that all options in the are unavailable because the variables are not recognized as dates.
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Figure 10: Dates Not Recognized

Select the Date column, go toData Type, and set the data type to Date. This will enable the Power
Query editor to properly recognize that the Date column consists of dates.
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Now, let’s add additional columns to this dataset. Navigate to Add Column, select Date, and from
the dropdown menu, choose Month. Refer to Figure 12 for the process displayed in the Power Query
Editor. Following a similar process, we will add Weeks to this dataset.
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Figure 12: Adding Column: Month

Load to Excel: Connections Only

Once you have added the months and weeks, return to the Home tab in the Editor and select Close
& Load To. In the pop-up window, click Only Create Connectionand select OK.If you wish to use
the Power Pivot function, you may also check the Add this data to the Data Model option.

= | Attendance - Power Querv Editor [m] X

Home  iranstorm  Adalolumn  View (%)
| {_j [ Properties I:l X Data Type: Any ~ [ Merge Queries ~ D [ New Source ~
A TH = .
= [ Advanced Editor [ Use First Row as Headers ~ % Append Queries ~ 43! [ Recent Sources

i |

Close &|  Refresh Choose Remove  Keep Remove split  Group , i Manage  Data source
Load~ | Preview - [1Manage > Columns~ Columns = Rows~ Rows ™ Column~ By ‘2 Replace Values Combine Files Parameters~  settings [ Enter Data
&) Close& Load ' Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
fi || = Table.Adscorum (s Inserted ponth®, "uieek of Vear, each Date.eekOfVear([Date]), Int6s.Type) ~]| Query Settings %
. A Name ~] M Major -] R ciss -] Date -] 455 Artendance -] 125 Month -] 125 Weekof Year -
1 E o/a/2023 5 3 * PROPERTIES
Import Data ? X A Name
2 = ofef2023 9 3 fs—
3| seecthow you want t view this data inyour workbook: " o/e/2023 & 5 3
4 TS & o1/2023 A 9 7 Al Properties
5 121 ) BrTable Report & 9/13/2023 P s 57 4 APPLIED STEPS
5 e R 9/15/2023 p s E2
7 = spigf0zs A s B Souree
o | e e - pe B > Navigation
5 == E s v ; B i
10 L v B " sf2s/2003 s 33 Cromged Tyt
LM ks = 9/27/2023 P ° * Unpivoted Other Columns
2 & 92972023 » 9 3 Renamed Columns
1 x| cams R 10/2/2023 p b ) Changed Type2
14 — R 10/4/2023 P 0 ) Inserted Month
15 1ohn Doe ) = 10/6/2023 p 0 w X Inserted Week of Year
16 lohn Do BUs! = 10/9/2023 p 0 “
17 1omn Doe BUs! = 10/13/2023 A 0 “
18  1ohn Do BUs! = 10/13/2023 0 “
19 John Do BUs! & 1071612023 0 2
20 Jom Doe BUsI & 10/18/2023 0 @
21 Jomdoe BUs! = 102012023 10 @
22 jomdoe BUs! = 10/23/2023 10 s
23 Jomdoe BUs! = 107252023 10 s
24 JomDoe BUs! = 10/27/2023 A 10 s
25 Jom Doe Bus! R 10/30/2023 b7 “
26 Jom Doe BUsI R 11172023 P 1 “
27 Jom Doe BUSI R 11/3/2003 A 1 “ B
28 Jomm Doe BUsI = 11/6/2025 P 11 E

PREVIEW DOWNLOADED AT 1:46 PM
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Figure 13: Loading to Excel



In contrast to our previous cases, we will not be directly importing the data into this new workbook
but merely creating a connection. Notice in Figure 14 that no actual data has been imported, but there

is a connection shown in the .

Fle Home Insert Pagelayout Formuas Data Revew View Automate Help  Power Pivot 4 sh
sies & Connections N 2 = - -
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Figure 14: Connection Created

Even though the data is not included in this specific workbook, we can still create a PivotTable due to
the connection we just established. Navigate to the Insert tab and select PivotTable, but be sure to
choose From External Data Source. Then, in the new pop-up, select Choose Connection and
confirm that the external data source is the Query-Attendance that we just created.
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Figure 15: PivotTable with External Connections



Then, we can use the standard PivotTable framework to generate tables that show us the attendance
status of all students over three months as shown in Figure 16.

A 3 c o 3 F G H ) K L ™ N o 3 Q R s T u va

1 [Major Tan 2 PivotTable Fields voX
2 [Month (al) -

T - (i) = Choose fields to addto report: &~
P

5 Countof Attendance Attendance - [[searc 0
& Name ~ Present Absent Holiday

7 |Alex Johnson 2 4 2 Attendance

& |Ava Rodriguez 33 3 2 [ Class.

9 Brian Taylor 31 5 2 [ Date

10 |chloe Anderson a1 s 2 Major

11 |Daniel Lee E 2 Month

12  Emily Davis a1 s 2 5 Nome

13 |Emma Garcia 8 8 2 g

14 |EricRobinson 2 4 2

15 |Ethan Hall 34 2 2 Weelcof Year

16 |Jackson Adams 31 5 2 More Tables.

17 Jane Smith 33 3 2

18 |Jessica White » 7 2

19 John Doe 27 9 2

20 |Lily Moore En 2 2

21 Matthew Miller 0 6 2

22 | Michael Brown a5 2 Drag fields between areas below:

23 Nathan Turner 29 7 2 Y Fiters B Columns

24 Olivia Wilson s 2 2

25 Sarah Martinez 28 8 2 Major - Attendance -
26 |Sophia Clark 27 9 2 Month -

27 Grand Total 618 102 40

= Week of Vear -

2

30

l = Rows % Values.

2

3 Neme ||| countof attendance ~
34

35

36

37

3

Figure 16: Completed PivotTable



Topic 2. Merging Data: Manual Approach

Sometimes, we may encounter situations where we need to merge data from different sources. For
example, open the workbook BUSI201-LEC20-Workbook.x1sx and go to the worksheet Shell. As
shown in the accompanying Figure 17, you will find a worksheet with student IDs, names, classes, and
majors, where the quiz, midterm, and final scores are currently empty.

A B T D E F G H J K L M N C
1 SID 1 Name Major Class Quiz Midterm Final
2 39630 John Doe BUSI FR
B 88741 Jane Smith ACCT SO
4 58518 Alex Johnson ECON SR
5 69909 Emily Davis ECON S0
6 43307 Michael Brown ACCT FR
7 49372 Olivia Wilson ACCT SO
8 95461 Daniel Lee BUSI 50
9 55398 Sarah Martinez ECON JR
10 62040 Brian Taylor ACCT JR
1 32403 Chloe Anderson BUSI JR
12 34358 Eric Robinson ECON FR
13 10536 Jessica White BUSI SO
14 30357 Matthew Miller BUSI JR
15 49615 Emma Garcia ECON SO
16 28778 Nathan Turner ECON FR
17 33565 Lily Moore ECON JR
18 69282 Ethan Hall ECON 50
19 92750 Sophia Clark ECON SR
20 47053 Jackson Adams BUSI S0
21 97585 Ava Rodriguez BUSI S0
Attendance Quiz Midterm Final  Shell +

Figure 17: Shell Worksheet

To manually merge information, we must first identify a unique identifier. If there is no unique
identifier, we must create one. Fortunately, in this specific case, the student ID number (SID) serves
as a unique identifier. With a unique identifier available, we can use the VLOOKUP function to retrieve
students’ performance data from the other three worksheets.

Specifically, the formula we must use will be:

« E2: =VLOOKUP($A2,Quiz!$A$2:$E$21,5,0)

* F2: =VLOOKUP($A2,Midterm!$A$2:$E$21,5,0)
* G2: =VLOOKUP($A2 Final!$A$2:$E$21,5,0)

See Figure 18 for the manually merged results.

A B C D E F G H J K

1 SID | Name Major Class Quiz Midterm Final

2 39630 John Doe BUSI FR 65.883544 63.848031 89.667084
3 88741 Jane Smith ACCT SO 70.622386 76.023977 94.590742
4 58518 Alex Johnson ECON SR 44.240421 59.19928 94.398706
5 69909 Emily Davis ECON SO 32.011265 73.41517 95.950031
6 43307 Michael Brown ACCT FR 22.790446 90.155576 91.733427
7 49372 Olivia Wilson ACCT SO 72.342314 95.111828 90.850339
8 95461 Daniel Lee BUSI SO 100 78.101099 98.221627
9 55398 Sarah Martinez ECON JR 77.773608 88.937366 87.426706
10 62040 Brian Taylor ACCT JR 74.419605 100 90.713715

Figure 18: Manually Matched Values
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Topic 3. Power Query: Merging Data

We can also rely on Power Query to merge the data instead of manually merging it. Open another
workbook and import the workbook BUSI201-LEC20-Workbook . x1sx into the Power Query Editor.
Select the entire workbook, as shown in Figure 19, and choose Transform Data.
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Figure 19: Importing the Entire Workbook

Select the tables in thered boxin Figure 20. Right-click and select Add as New Query. Each table
will be added as a new query in the . After adding each element as a new query, you may need

to navigate to each individual query to set Use First Row as Headers.

&~ = | BUSI201-LEC21-Workbook xlsx - Power Query Editor o X
ry
Home: Iranstorm Add Column View (7]

fij D [} Properties L XY, EDX Data Type: Table [ Merge Queries ~ D [™ New Source
e Lé B X 35 =

[ Advanced Editor [T Use First Row as Headers * % Append Queries ~ [ Recent Sources

DN ND
= &

Close & Refresh = Choose Remove  Keep Remove split  Group 1 ! - Manzge | Data source | oy

Load~  Preview~ - Manage Columns~ Columns~  Rows~ Rows™ Column~ By »2ReplaceValues Gl Parameters™  settings (Er Bt
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query

Queries 1 < Jx || = Excel.uorkbook(File.Contents("C:\Users\Brian\Dropbox\Teaching\Monmouth College\[BUSI201] Business Dats v

== Query Settings X
T BUSIZ01-LEC21-Work... ) J

. A Name - | b ] m em -] s Kind -] % Hidden
4 PROPERTIES
1 Arendance ravie rctendance sneat FaLsE N
2 Quiz [Table Quiz. Sheet FALSE
3 Midterm [Tabie [Midterm Fhone FALSE =
4 Final Table Finel ,E‘@ Copy FALSE
5 shel [ravie snei 3 FALSE

Drill Down

[Aaasnewawey ] =

Cowmnl  Column2 Comn3  Colmed  Columns  Column6  Column?  Columng Calumng Comn10  Columnll  Coumnlz  Coumnl3  Colmnld  Columnls
sD Name Major Class S Sfo2003 Sy YIS SN YIS0 SN /M /0B 205 S/
39630 John Doe: BUSI & ° ° A A ° P A ° 3 ° °
88741 Jane Smith Acct s0 3 3 A 3 3 P 3 3 3 ° 3 7
< >

PREVIEW DOWNLOADED AT 427 PM.

Figure 20: Adding Tables to Query
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To merge the data and achieve a result similar to the final product in Topic 2, start by selecting the
Quiz_Sheet query. Then, choose Merge Queries as New to create a new query that can be exported
later. Alternatively, you can select Merge Queries to merge the data directly into the Quiz_Sheet

query.

N , S S T - S ~ . .
8 < | Quiz_Sheet - Power Query Editor [m] X
Home  iransiorm  AddColumn  View v
| ﬁr—j [ Properties I:l L X 4 Y 3 Daatype Whole Number = |5 Merge Queries|~] D [™ New Source ~
= & [ Advanced Editor X EEEQEE il (i [E7] Use First Row as Headers ~ [ Merge Queries o) [ % Recent Sources
Closed  Refresh . Choose  Remove  Keep Remove split  Group = - e Datasource
Load™  Preview 1] Manage Columns * Columns™  Rows™ Rows™ Column~ By 2 ReplaceValues 3 MergeQueriesasNew  fror gegings [ Enter Data
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
< fi || = Table.TransfornColumTypes (#"Promoted Headers®,{{"SID", Int64.Type}, {"Name", type text}, {"Major", type text}, {"Class", type text}, {"Quiz’, type number}}) ~| Query settings x
BUSI201-LEC21-Work...
— . 12 sID -] M Name ~] rc Major < ¥ cass ~]12 quiz -
T Attendance_Sheet 4 PROPERTIES
— 1 39630 John Doe BUSI B 6588354366
o 2 8871 Jane Smith accr s 706223857 ome_
X Midterm Sheet 3 58518 Alex Johnson ECON SR 4424042112 QuizSreet
I Final Sheet 4 69509 Emily Davis Econ s 5201125485 Al Properties
s 43307 wichsel Brown accr " 2275084558 4 APPLED STEPS
6 45372 v Wison accr s0 r2sazss2
7 5451 Daniel Lee BUs! s 00 ;"a“v:;m
8 5538 Sarsh Marine: £con ® 7777360756 o
9 62040 rian Taytor accr ® 7241560488 R
10 52403 Crios Anderson Bust ® 71991
n 54358 Erc Ropinson £con B oo 76554048
2 10536 Jessica Whice Busi 50 60.24126946
3 30357 Matthew Miller BUsI R 7296911753
1 45615 Emma Garcia Econ 50 0
15 26778 Nathan Tumer Econ = 871200835
16 33565 Lily Moore ECON R 73.00066166
” 65282 Ethan Hall Econ s 0
18 92750 Sophia Clark ECON SR 60.27351352
19 47053 ssckson Acams Bust s0 sea17om2is
2 7585 Ava Rodriguez Bust s0 sg.08377044

ROWS _ Column profiin

on top 1000 rows

Figure 21: Initiate Merge

In the pop-up window, select the query that holds the data you want to merge with Quiz_Sheet to

X s |au ower Query Edito [m] X
Home Iranstorm Add CLolumn View L 7]
S % Properties L X 4 1 T3 Data Type: Whole Number © [ Merge Queries ~ [ New source
] ~ i X R im | ml — - Q
=~ [ Advanced Editor X\ [ & Recent Sources -
Close & Refresh D Choose Remove Merge Manage Data source D
Load~  Preview~ L Manage Columns ™ Columns~ | 9 Parameters~  settings Erteqbats
Close @y (e @S Select tables and matching columns to create a merged table, Parameters  Data Sources ey
5 < fi || = Teble.Transrormcorumntypes (s | QUzSheet 2 pquiz, type number)) | Query settings x
T BUSI0T-LEC21-Work. - 1. e : E
— . i 5o - ¥ Name ame ojor | Cass | Quiz
T Attendance Sheet sgsofpomooe  us || esesssases 4 PROPERTIES
— 1 39630 Jom bos
" Quiz_Sheet ~ 88741 })ane Smith ACCT S0 70.6223857 Name
2 86721 Jane smitn 2
= lex Johnson Quizs
T2 Midterm_Sheet 5 e sostg|mextonson |ECON || 4s2e0m112
= Final Sheet 5 s oy oo sososfemiypavs  econ  |so | szouzesss Al propertes
as307|mcraeiBroun Accr || 22708558
5 43307 Michael Broun s 4 APPLIED STEPS
6 49572 Olvia Wison ; .
7 95451 Daniel Lee Midterm_Sheet - | 3 N"“"i
g 25536 Sarsh Martinez SID Name Major Class. Midterm Promoted Headers
9 (B2EXC) Beian Taylor 39630 §sohn Doe BUSI FR 63.84803122  Changed Type
o 32803 Chlae Anderson 88741 |1ane Smith AcCCT S0 76.02397659
il [$4338| Eric Robinson 58518 | Alex Johnson | ECON SR 5919927957
e 20536] lessica White 69909 J Emily Davis ECON SO 7341516977
3 R Mthew Willer 43307 | Michael Brown ACCT FR 90.1555764
" 49515 Emma Garcia —
15 28778 Nathan Turner Joip Kind
s 33565, Liy Moore [ et Outer (o rom first, matehing from second) -1
” 65282 Exman bl Use fuzzy matching to perform the merge
18 92750 Sophia Clari
19 47053 Jackson Adams. ¥ Fuzzy matching options
20 97585 Ava Rodriguez

v/ The selection matches 20 of 20 rows from the first table. Cancel

0WS _ Column profiing based on top 1000 rows PREVIEW DOWNLOADED A1

Figure 22: First Round of Merging
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We need to make some changes to the newly generated query. Click the dropdown menu in the
in Figure 23. Uncheck all elements other than the variable you want to include in the query,
as seen in the You may also uncheck the Use original column name as prefix for

brevity.

{ II &~ 5 | Merge1 - Power Query Editor o X
Home Iransiorm Aad Column view w

|
| & [} Properties al Data Type: Table [T Merge Queries ~ [™ New Source ¥
&2 [ : = T &
! [ Use First Row as Headers ~

[ Advanced Editor 7T Append Queries ~

z [ % Recent Sources -
Close & Refresh Choose Remove  Keep Remove split  Group . Manage  Data source
Load~  Preview~ L1 Manage ~ Columns~ Columns~  Rows~ Rows™ Column~ By ‘2 ReplaceValues Gtz e Parameters™  settings Eenter Data
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
Q < fi || = Table.Nesteadoin(quiz_sheet, {SID"}, Midtern Sheet, {"SID"}, "Midterm Sheet”, Joinkind.Leftouter) ~| Query Settings X
BUSI201-LEC21-Work...
- . 2 5D <] % Name ~] e Major <] % Cass 12 quiz =] 7 Midterm_Sheet E
I Attendance_Sheet 4 PROPERTIES
e Shest ; ::, jm :oeh :?T :: Search Columns to Expand 8 Nome
ane smi
2 Midterm Sheet 3 58518 | Alex Johnson ECON SR © boend O hosregee Meree!
I3 Final Sheet . 53505 ity Do coon “ ] (Select All Columns) Al Properties
0 Mergel 5 43507 Michael Brown accr rr( s .
6 49372 Olivia Wilson AccT S0 Neme APPLEDSTERS
7 5461 Dariel Lee BUsI 0 !:J: Somem
8 55308 Sarah Martinez EcoN » e
9 62040 Brian Taylor accr » e
10 32403 Chioe Anderson BUSI R Use original column name 35 prefix I
1 54358  Eric Robinson econ =
12 10536 | Jessica White BUSI S0 Cancel
3 50357 Matzhew Miller Bus! ® 7296911753 TabE
1 49615 Emma Garcia econ s 100 Table
15 26778 Nathan Tumer Econ = 57.1204855 | Table
1 33565 Liy Moore Econ » 75.00085166  Table
” 59282  Ethan Hall Econ s 100 Table
18 92750 Sophia Clark. ECON SR 6027391392 Table
19 47053 Jacksan Adams Bus! 50 5881797215 Teble
» 57585 Ava Rodriguer BUsI 50 9808377044 Table

PREVIEW DOWNLOADED AT

Figure 23: First Round of Merging (cont’d)

The newly generated query resulting from the steps detailed above is visible in Figure 24. We can
complete this merging process by following similar steps to merge final exam data into this new Mergel

query.

| < | Merge1 - Power Query Editor (m] X
Home  ranstorm  Adaloumn  view v

A

| & [ Properties L X 4 1 Data Type: Decimal Number =[] Merge Queries ~ [ New Source
g L& . B % 08 4 dh = : &
#~ [ Advanced Editor il [T Use First Row as Headers ~

T Append Queries ~ [ Recent Sources

Close&  Refresh o Choose  Remove  Keep Remove split  Group : ! I Manage  Datasource
Load~  Preview - - Manage Columns~ Columns~  Rows~ Rows~ Column~ By »2ReplaceValues el Parameters ™ settings (Er B
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
Queres < fi || = Tab1e.Expanaaviecotumn(source, “idterm_sneets, {pictern®), {“Hictern'}) | Query settings o
T BUSIZ01-LEC21-Work...
_ . 12 sip ~] M Name ~| M Major <] % Class -]12 Quiz ~ 12 Miderm -
T Attendance_Sheet 4 PROPERTIES
— 1 55630 1ohn oe Bust & 6588354368 6384507122
I Quiz Sheet Name
2 85751 sane smitn accr s0 ros223857 7602397659
Widterm Shest Mergel
: 3 58518 Alex omnson £con = 4220002112 5919927857
I Final Sheet 4 69509 Emiy Davis £con s 201126983, 7341516977 Al Properties
T Werget s 43307 Nichsel Brown accr B 2279084558 01555764 4 APPLIED STEPS
6 49372 Olivia Wilson ACCT S0 723423142 95.11182753 s
7 95461 Daiel Lee Busi 50 10 7810109853
X Expanded Midterm Sheet
8 55358 Sareh Martinez Econ R 7777360756 8895736639
9 62040 Brian Tayior Acct R 7441560485 100
10 52403 Chioe Anderson BUsI R 72571991 6226715078
1 34358 Erc Ropinzon ECoN ® 67655004 e7s7331
2 10536 Jesics White BUsI s 624128015 92.20209547
1 30357 Matthew Miller Bust » 7296011755 844023014
1 4615 Emms Garca £con s0 10 sssss07312
15 26778 Nathan Tumer £con " 871201835 7586425166
1 33565 Liy Moore £con =® 75.00065166 8840751056
” 5252 Eman vl £con s0 10 83.40013971
1 2750 Sophia Clark £con = c027391392 100
19 47053 1ackson Acams Bust s Saa1797215 7052857179
20 57585 Avs Roariguez Bust s sg.08377084 7235184801

PREVIEW DOWNLOADED AT

Figure 24: First Round of Merging Completed
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= | Merge1 - Power Query Editor

“ Home Iranstorm ‘Ada Lolumn Vview
,Sj % Properties l:l L Ky, EpX 5| 1 % Data Type: Decimal Number = [55] Merge Queries ~
(= 54 [ Advanced Editor X HH HH Al it [ Use First Row as Headers ~ "5 Append Queries ~
Close 8  Refresh Choose  Remove Keep Remove split  Group ;
Load~  Preview~ L Manage Columns~ Columns~  Rows~ Rows~ Column~ By 22 Beplaceliaiuey Cenlsmefl=
Close Query Manage Columns Reduce Rows  Sort Transform Combine
< Ji || = Table.ExpandTableColuan(Source, "Midterm_Sheet”, {"Midterm'}, {"Migtern"})
BUSI201-LEC21-Work...
. 123 SID ~| A Name ~ | A Major ~| M Class ~ 12 quiz ~ 12 Midterm 2
Attendance_Sheet
1 59630 1ohn oe Bust B G5 88354368 63 84507122
Quiz Sheet 2 88741 Jane Smith ACCT so 70.6223857 76.02397659
Midterm_Sheet 3 58518 | Alex Johnson ECON SR 44.24042112 59.19927957
Final Sheet 4 69509 Emily Davis ECON S0 32.01126483 7341516577
Mergel 5 43307 Michael Brown AccT R 2279044558 901555764
6 45372 Oivis Wison acct s 2348102 9511182753
7 55461 DanilLee BUsI s 100 7810109853
2 55358 Sarsh Marinez £con » 727360756 8295736650
9 52020 Brin Taytor accr =® 7241560488 100
10 32403 Crioe Anderson Bust =® 74571991 6226715079
n 34356  Eric Robinson £con " 6s.76554084 &7s73a321
2 10536 sessca whte Bust s0 6924128945 93.20209547
2 30357  Matthew Miler Bust =® 7256811753 8440236014
1 45615 Emma Garcia £con s 10 sssss07312
15 26775 Natnan Tumer £con B &7.120i835 7586425166
1 33565 iy Moore £con ® 75.00066166 8840751056
- 5252 Eman vl £con s 10 83.40013971
18 52750 Sophis lsrk £con = c027391392 100
19 47053 Jackson Adams BUsI 50 sa81757215 7052857175
2 57585 Ava Rodriguez Busi 50 38.08377044 7235184801

[m] X
v
D [ New Source
Q [ % Recent Sources -
Manage  Data source |
Parameters~  settings T Enter Data
Parameters  Data Sources New Query
¥1 Query Settings X
4 PROPERTIES
Name
Merget
Al Properties

4 APPLIED STEPS
Source
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Figure 25: All Data Merged in Query

PREVIEW DOWNLOADED AT 420 PM.

To merge the final exam information into this query, select Merge Queries this time instead of
Merge Queries as New, and follow the exact same steps. Choose the student ID numbers, and go
through the checkboxes. The Merge1 query following this process is shown in Figure 25. Importing this
query into Excel, the result is displayed in Figure 26.

A B G D E F G
{lSID g Name g Major gClass g Qui g Midterm inal
2 39630 John Doe BUSI FR 65.88354368 63.84803122
3 88741 Jane Smith ACCT SO 70.6223857 76.02397659
4 58518 Alex Johnson ECON SR 44.24042112 59.19927957
5 69909 Emily Davis ECON SO 32.01126483 73.41516977
6 43307 Michael Brown ACCT FR 22.79044558 90.1555764
7 49372 Olivia Wilson ACCT SO 72.3423142 95.11182753
8 95461 Daniel Lee BUSI SO 100 78.10109853
9 55398 Sarah Martinez ECON JR 77.77360796 88.93736639
10 62040 Brian Taylor ACCT JR 74.41960488 100
11 32403 Chloe Anderson BUSI JR 74.971991 62.26719079
12 34358 Eric Robinson ECON FR 69.76554044 67.57332321
13 10536 Jessica White BUSI SO 69.24128946 93.20209547
14 30357 Matthew Miller BUSI JR 72.96911753 84.40236014
15 49615 Emma Garcia ECON SO 100 69.94307312
16 28778 Nathan Turner ECON FR 87.1204835 75.86425166
17 33565 Lily Moore ECON JR 73.00066166 88.40781056
18 69282 Ethan Hall ECON SO 100 83.40013971
19 92750 Sophia Clark ECON SR 60.27391392 100
20 47053 Jackson Adams BUSI SO 58.81797215 70.92857179
21 97585 Ava Rodriguez  BUSI SO 98.08377044 72.35184801
22

89.66708395
94.59074178
94.39870638
95.95003058
91.73342698
90.85033899
98.22162731
87.42670642
90.71371502
84.57406171
86.69297478
97.07938781
93.17842013
88.48818443
95.65823593
92.30112903
94.87143174
87.99410653
88.74993291
86.68562663,

Figure 26: Merged Query Imported
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